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1 1 Introduction

1.1 1.1 Welcome

This help manual documents Audio-Mp3 Convert Expert. Please e-mail any questions you have to the
following address:
     support@bluecygnet.com

We will try to respond to inquiries within two to three business days.

If you have any comments or suggestions, please e-mail them to:
     support@bluecygnet.com

For the latest information on Audio-Mp3 Convert Expert and Bluecygnet Technologies, check out our
home page:

     http://www.bluecygnet.com

Thank you!

The Audio Mp3-Convert Expert Product Team

Copyright and trademark notices

1.2 1.2 Html Help Tips

This topic provides some tips on customizing the font size and printing help topics using HTML
Help.

Customizing the Font Size

The font size used when viewing this documentation is directly related to the font size and settings
used by Internet Explorer. This help documentation is designed to display content at a preset font
size. However, you can override the font size by modifying the settings in Internet Explorer.

To customize the font size in Internet Explorer 4.0 and 5.0 (where Internet Explorer 4.0 instructions
differ from 5.0, 4.0 items are shown in parenthesis):

    Open the Tools (View) menu and select Internet Options.
    Click on the Accessibility button.
    Click on the Ignore font sizes on Web pages option.
    Click OK twice to return to the main Internet Explorer window.
    Open the View menu and select Text Size (Fonts) and choose from among the available font sizes.

Printing Help Topics

With HTML Help, an entire top-level book can be printed at once, allowing you to print the entire
documentation with a few print commands. To print all of the topics contained in a book, right-click on
the book you wish to print and select Print from the pop-up menu. Select the Print the selected
heading and all subtopics option (see dialog below) and click on the OK button.

http://www.bluecygnet.com
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You also have the option of printing a single topic by selecting the appropriate option in the Print
Topics dialog (above).

1.3 1.3 How To Print This Help File

We do not recommend to print this help file as the print capabilities of the Microsoft help viewer is
rather scanty.

If you want a printed version of this help file, please download the online help in PDF format from our
download page:

     http://www.bluecygnet.com/support/manuals.htm

1.4 1.4 What is Audio-Mp3 Convert Expert

One of those must have utilities, indispensable for converting audio files from one format to another.
Audio-Mp3 Convert Expert is a powful audio formats converting software. With the simple, easy to
access interface, you do not have to be a genius when using the program.

Audio-Mp3 Convert Expert requires Windows 98,ME, Windows NT 4.0, Windows 2000, or Windows
XP.

For a list of new feature in Audio-Mp3 Convert Expert, see New in Audio-
Mp3 Convert Expert v1.23 .

Audio-Mp3 Convert Expert is highly customizable and easy to use.

1.5 1.5 New in  Audio Mp3-Convert Expert  1.23

New Features

  * Multi-languages support

Please see History.txt in the Audio-Mp3 Convert Expert program group for additional information on
minor changes and bug fixes.

http://www.bluecygnet.com/support/manuals.htm
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1.6 1.6 System Requirements

Minimum System Requirements

    486-based PC

    32 MB RAM

    Windows 95/98, ME, Windows NT 4.0, Windows 2000, or Windows XP

1.7 1.7 Product Announcements

If you would like to receive e-mail notification of new releases, send e-mail to:

     support@bluecygnet.com

with the following in the message subject and body:

subscribe amce-announce

Also, visit our web page:

     http://www.bluecygnet.com

2 2 Getting Started

2.1 2.1 Installation

The installation program for Audio-Mp3 Convert Expert is contained in the self-extracting executable
file available for download at http://www.bluecygnet.com/download. To begin the installation process,
simply run the self-extracting executable file.

The Audio-Mp3 Convert Expert installation process is comprised of several screens that allow you to
modify the installation behavior of certain components of Audio-Mp3 Convert Expert. To proceed from
one screen to the next, click on the Next button. If you need to change any of your modifications
before finishing the installation, you can click on the Back button.

The first step in the installation process is to read carefully through the Audio-Mp3 Convert Expert
License Agreement. If you agree to all the terms in the license agreement, then click on the Yes
button to continue with the installation.

After accepting the Audio-Mp3 Convert Expert License Agreement, you will be presented with the
installation's information screen. Upon proceeding to the next screen, you will be asked to specify the
directory in which you would like to install Audio-Mp3 Convert Expert.

After selecting the desired directory for installation, proceed to the next screen.

You will then be presented with the opportunity to modify Audio-Mp3 Convert Expert shortcut and icon
locations (Start Menu, Desktop, Program Group).  If you selected, you will then be asked if you would
like to add Audio-Mp3 Convert Expert icons and links to the the Start menu and Desktop.

2.2 2.2 Technical Support

   Please send your questions or bug report to support@bluecygnet.com.

http://www.bluecygnet.com
http://www.bluecygnet.com/download
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3 3 Using The Software

3.1 3.1 Getting To Know The Window

3.1.1 The Toolbar

   

Button Function

Add Add file to list

Remove Remove file from list

Analysis Analysis your log file

Download Download log file from internet

Help Help document

Purchase Purchase the software

3.2 3.2 Add File To List

 

   Please select main menu File > Add .

3.3 3.3 Remove File From List

  Please select main menu File > Remove selected or Remove All.
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3.4 3.4 Convert

3.4.1 WAV to MP3

Audio-MP3 Convert Expert uses LAME MP3 encoder as default MP3 encode engine. LAME encoder
is a freeware project which provides high compression speed and perfect sound quality, it supports
VBR(Variable Bitrate) and many more features.

  
To start converting mp3 files, you need to click main menu Convert > WAV to MP3.

http://www.mp3dev.org
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3.5 3.5 Options

3.5.1 General

  Output Directory

  Default output directory.

3.5.2 MP3 Options

 

  Bitrate

  Bitrate (i.e. size) of MP3 file in kBit/s. Allowed bitrates are: 32, 40, 48, 56, 64, 80, 96, 112, 128,
160, 192, 224, 256 and 320. Default   value is 320.
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MaxBitrate

  For CBR this setting is ignored, when using VBR, it specifies the maximum bitrate.

  DisableVBR

  Specifies if VBR encoding option shall be used or not, possible values are TRUE/FALSE.

  VBR Quality

  Quality option if VBR is enabled, 0=highest quality, 9 is lowest quality

  Mode

  Stereomode for MP3 file. This can be either STEREO, JSTEREO, DUALCHANNEL or MONO.

  Quality

  The MPEG quality LAME_ENC will used when VBR is enabled.

  SampleRate

  Samplerate in Hz for MP3 file. This can be set to either:
32000, 44100 or 48000 for MPEG-I

    16000, 22050 or 24000 for MPEG-I
    8000, 11025 or 12000 for MPEG-II.5

  Original

  If this is set to TRUE the Original bit in the MP3 stream will be set.

  CRC

  Set this to TRUE in order to enable CRC-checksum in the bitstream.

  Private

  If this is set to TRUE the Private bit in the MP3 stream will be set.

  Copyright

  If this is set to TRUE the Copyright bit in the MP3 stream will be set.

  Disable writing of VRE Tag

  Sepecifes if the a XING VBR header should be written or not. When this  option is enabled, you
have to call the beWriteVBRHeader     function when encoding has been completed.

4 4 How To Purchase

Registration may be placed by one of the following methods:

1: Secure online credit card transaction
    Please go to our Web site: http://www.bluecygnet.com/purchase/index.htm for more information.

2. You can go to http://www.shareit.com and enter the program ID number 166610 in the search
window at the bottom left of the screen. We also accept orders via email at: support@shareit.com

3. Order by Phone

http://www.bluecygnet.com/purchase/index.htm
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You may place credit card orders by calling +49-221-31088-20. US and Canadian customers may call
toll-free 1-800-903-4152.

4. Order by FAX or Postal Mail
    If you wish to order by FAX or Postal Mail, please complete and print out the order form and send it
with your payment.

5. Purchase Order
    If you are interested in payment by purchase order, please contact support@shareit.com for
additional information.

NOTE:
    Please include the product ID 166610  when you order by Phone, FAX or Postal Mail.

5 5 Frequently Asked Questions

5.1 5.1 Technical Questions

1. What is Audio-MP3 Convert Expert?

Audio-MP3 Convert Expert is an audio formats converting software. It supports converting audio
formats MP3 and WAV from one format to another. The following lists most of the functions supported
by Audio-MP3 Convert Expert.

¡¤Convert WAV to MP3

Set converting settings that includes bit rate, sampling frequency, channels, and more.

2. What is Variable bitrate (VBR)?
In this mode, you choose the desired quality on a sqale from 9 (lowest quality/biggest distortion) to 0
(highest quality/lowest distortion). Then encoder tries to maintain the given quality in the whole file
by choosing the optimal number of bits to spend for each part of your music. The main advantage
is that you are able to specify the quality level that you want to reach, but the inconvenient is that
the final file size is totally unpredictible.

3. What is Compression ratios, bitrate and quality?
It has not been explicitly mentioned up to now: What you end up with after encoding and decoding is
not the same sound file anymore: All superflous information has been squeezed out, so to say. It is
not the same file, but it will sound the same - more or less, depending on how much compression had
been performed on it.
Generally speaking, the lower the compression ratio achieved, the better the sound quality will be in
the end - and vice versa. Table 1.1 gives you an overview about quality achievable.
Because compression ratio is a somewhat unwieldy measure, experts use the term bitrate when
speaking of the strength of compression. Bitrate denotes the average number of bits that one second
of audio data will take up in your compressed bitstream. Usually the units used will be kbps, which is
kbits/s, or 1000 bits/s. To calculate the number of bytes per second of audio data, simply divide the
number of bits per second by eight.

Table 1.1 Bitrate versus sound quality
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Bitrate Bandwidth Quality comparable to or better than

16 kbps  4.5 kHz shortwave radio

32 kbps  7.5 kHz  AM radio

96 kbps 11 kHz FM radio

128 kbps 16 kHz near CD

160-180 kbps (variable bitrate) 20 kHz perceptual transparency

256 kbps 22 kHz studio

4. What is ID3 (v1)?
The audio format MPEG layer I, layer II and layer III (MP3) has no native way of saving information
about the contents, except for some simple yes/no parameters like "private", "copyrighted" and "original
home" (meaning this is the original file and not a copy). A solution to this problem was introduced with
the program "Studio3" by Eric Kemp alias NamkraD in 1996. By adding a small chunk of extra data in
the end of the file one could get the MP3 file to carry information about the audio and not just the audio
itself.

The placement of the tag, as the data was called, was probably chosen as there were little chance that
it should disturb decoders. In order to make it easy to detect a fixed size of 128 bytes was chosen.
The tag has the following layout (as hinted by the scheme to the right):

Song title      30 characters
Artist            30 characters
Album           30 characters
Year               4 characters
Comment      30 characters
Genre             1 byte

If you one sum the the size of all these fields we see that 30+30+30+4+30+1 equals 125 bytes and not
128 bytes. The missing three bytes can be found at the very end of the tag, before the song title.
These three bytes are always "TAG" and is the identification that this is indeed a ID3 tag. The easiest
way to find a ID3v1/1.1 tag is to look for the word "TAG" 128 bytes from the end of a file.

As all artists doesn't have a 30 character name it is said that if there is some bytes left after the
information is entered in the field, those bytes should be fille with the binary value 0. You might also
think that you cannot write that much in the genre field, being one byte big, but it is more clever than
that. The byte value you enter in the genre field corresponds to a value in a predefined list. The list that
Eric Kemp created had 80 entries, ranging from 0 to 79.

5. What is ID3v2?



Weblog Analysis Expert standard help11

?2001 ...2002 Bluecygnet Technologies.

ID3v2 is a new tagging system that lets you put enriching and relevant information about
your audio files within them. In more down to earth terms, ID3v2 is a chunk of data
prepended to the binary audio data. Each ID3v2 tag holds one or more smaller chunks of
information, called frames. These frames can contain any kind of information and data you
could think of such as title, album, performer, website, lyrics, equalizer presets, pictures etc.
The block scheme to the right is an example of how the layout of a typical ID3v2 tagged
audio file may look like.

One of the design goals were that the ID3v2 should be very flexible and expandable. It is
very easy to add new functions to the ID3v2 tag, because, just like in HTML, all parsers will
ignore any information they don't recognize. Since each frame can be 16MB and the entire
tag can be 256MB you'll probably never again be in the same situation as when you tried to
write a useful comment in the old ID3 being limited to 30 characters.

Speaking of characters, the ID3v2 supports Unicode so even if you use the Bopomofo
character set you'll be able to write in your native language. You can also include in which
language you're writing so that one file might contain e.g. the same lyrics but in different
languages.

Even though the tag supports a lot of byte consuming capabilities like inline pictures and
even the possibility to include any other file, ID3v2 still tries to use the bytes as efficient as
possibly. If you convert an ID3v1 tag to an ID3v2 tag it is even likely that the new tag will be
smaller. If you convert an ID3v1 tag where all fields are full (that is, all 30 characters are
used in every field) to an ID3v2 tag it will be 56 bytes bigger. This is the worst case scenario
for ID3v1 to ID3v2 conversion.

Since it's so easy to implement new functionality into ID3v2, one can hope that we'll see a lot
of creative uses for ID3v2 in the future. E.g. there is a built-in system for rating the music
and counting how often you listen to a file, just to mention some brainstorm results that are
included. This feature can be used to build playlists that play your favourite songs more often
than others.

Example of the internal layout
of an ID3v2 tagged file.

6.What is Lyrics3?
When Winamp introduced its plugin capabilities Kuo (Djohan) Shiang-shiang's Lyrics Displayer was
one of the first plugins, and probably the first program that made a connection between MP3 audio and
lyrics. The lyrics displayed by Kuo's Lyrics Displayer were stored in separate text files from which the
program got it.

Petr Strnad saw the problems in this so he decided to make a lyrics tag, enabling the text to reside
inside the audio file. This is done by creating a chunk of data which begins with "LYRICSBEGIN", ends
with "LYRICSEND" and has the lyrics between these keywords. This data block is then saved in the
audio file between the audio and the ID3 tag. If no ID3 tag is present one must be attached.

The following simple rules applies to the lyrics inserted between the keywords:

The keywords "LYRICSBEGIN" and "LYRICSEND" must not be present in the lyrics.
The text is encoded with ISO-8859-1 character set
A byte in the text must not have the binary value 255.
The maximum length of the lyrics is 5100 bytes.
Newlines are made with CR+LF sequence.
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5.2 5.2 Registration Questions

1. What is shareware?
Audio-MP3 Convert Expert is distributed as shareware. The essence of shareware is to provide you
with software that you get to "try before you buy", while rewarding the efforts of the developers. When
you think about it, the opportunity to try before you buy is the ultimate guarantee of a product's quality
and usefulness to you. In fact, shareware can be just as professionally developed as software that
comes in a fancy box (with a lot of hype and yet no way to determine issues such as the "look and
feel", etc.), but the price of shareware can be set lower because it does not have to cover expensive
marketing costs. Still, software businesses that market their products as shareware need to get paid
for their efforts just as any other business. When you support the shareware concept, it ensures that
the concept will continue to work and you will continue to get to "try before you buy". Thank you for
understanding and honoring the "shareware" concept.

2.Is your online order form secure?
Yes, it is 100% secure.

3. How much is Webscript encoder standard?
The price for Audio-MP3 Convert Expert is US$24.95 per license.

4. How to register?
Please click here for details.

5. What happens after I submit my order?
Normally, you will receive your registration information immediately after sending the online order
form.

If you do not receive your registration information within 48 hours, or you have lost the registration
email, please contact us at support@bluecygnet.com. We will be glad to help you.

6.Do I have to pay for the upgrades?
No. All upgrades are free to registered users

5.3 5.3 Other Questions

1. I have more questions - who should I write to?
Please send your additional questions to support@bluecygnet.com.

6 6 License Agreement

END-USER LICENSE AGREEMENT FOR THIS SOFTWARE
       Important - read carefully:

IMPORTANT READ CAREFULLY:
This End-User License Agreement (EULA) is a legal agreement between you (either an individual or a
single entity) and THE AUTHOR for the software product identified above, which includes computer
software and may include online or electronic documentation (SOFTWARE PRODUCT or
SOFTWARE). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be
bound by the terms of this EULA. If you do not agree to the terms of this Agreement, you are not
authorized to use the SOFTWARE PRODUCT.

Copyright laws and international copyright treaties, as well as other intellectual property laws and
treaties protect the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is licensed, not sold.

If you do not agree to the terms of this agreement, do not use this software.  Because the software is
distributed as a fully-functional trial version, simply delete it.  If you've already purchased the
software, you may request a refund as long as you agree to destroy all copies of the software you
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have made.

GRANT OF LICENSE
This EULA grants you the following rights:

USE AND COPY
One registered copy of the SOFTWARE PRODUCT may either be used by a single person who uses
the software personally on one or more computers, or installed on a single workstation used non-
simultaneously by multiple people, but not both (or as outlined by multiuser licensing restrictions). You
may make other copies of the SOFTWARE PRODUCT for backup and archival purposes only.

RESTRICTIONS
Unregistered versions of the SOFTWARE PRODUCT may be used for a period of not more than 25
days. After 25 days, you must either stop using the SOFTWARE PRODUCT, or purchase a legal
license and obtain your registration key.

You must maintain all copyright notices on all copies of the SOFTWARE PRODUCT.

You may not sell copies of the SOFTWARE PRODUCT to third parties without express written
consent of THE AUTHOR and under THE AUTHOR's instruction.

EVALUATION copies may be distributed freely without charge so long as the SOFTWARE PRODUCT
remains whole including but not limited to existing copyright notices, installation and setup utilities,
help files, licensing agreements, run-time libraries, etc. and DOES NOT CONTAIN either valid serial
numbers, illegal serial numbers, or any other serial number not issued by the AUTHOR and or its
authorized representatives. In executing such an act, or similar copyright or license violation, to the
maximum extent permitted by applicable law you may be held liable for loss of revenue to THE
AUTHOR or THE AUTHOR's representatives due to loss of sales or devaluation the SOFTWARE
PRODUCT or both.

You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and
only to the extent that such activity is expressly permitted by applicable law notwithstanding this
limitation.

You may not rent or lease the SOFTWARE PRODUCT without the express written consent of THE
AUTHOR.

You may permanently transfer all of your rights under this EULA only in conjunction with a permanent
transfer of your validly licensed copy of the product(s) including the validation and registration key
information.

You must comply with all applicable laws regarding the use of the SOFTWARE PRODUCT.

TERMINATION
THE AUTHOR may terminate this EULA if you fail to comply with the terms and conditions of this
EULA. In such event, you must destroy all copies of the SOFTWARE PRODUCT including license
keys and ID information.

COPYRIGHT
All title and copyrights and intellectual property rights in and to the SOFTWARE PRODUCT and any
copies thereof are owned by THE AUTHOR.

REGISTRATION KEY CODE COPYRIGHT NOTICE
The registration key received and used to deactivate the time limiting trial period of this SOFTWARE
PRODUCT is NOT public and maintains full Copyright status. Any public display or public transfer of
this key will be considered a direct and intentional violation of this EULA and to the maximum extent
permitted by applicable law you may be held liable for loss of revenue to THE AUTHOR or THE
AUTHOR's representatives due to loss of sales or devaluation the SOFTWARE PRODUCT or both as
well as criminal fines for copyright infringement.
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NO WARRANTY
ANY USE OF THE SOFTWARE PRODUCT IS AT YOUR OWN RISK. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, THE AUTHOR DISCLAIMS ALL WARRANTIES AND
CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND
NONINFRINGEMENT.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL THE
AUTHOR BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY
OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE
SOFTWARE PRODUCT, EVEN IF THE AUTHOR HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

MISCELLANEOUS
Should you have any questions concerning this EULA, or if you desire to contact THE AUTHOR for
any reason, please send E-Mail to: support@bluecygnet.com.

Copyright (c) 2001-2002 Bluecygnet Technologies.
All Rights Reserved

7 7 Copyright and Trademark Notices

 Audio-Mp3 Convert Expert Copyright @ 2001-2002 Bluecygnet Technologies. All Rights Reserved.

 LAME, Originally developed by Mike Cheng (www.uq.net.au/~zzmcheng).  Now maintained by Mark
Taylor (www.mp3dev.org).

 Windows and Windows NT are registered trademarks of Microsoft  Corporation in the United States
and/or other countries.

http://www.bluecygnet.com/index.htm
http://www.uq.net.au/~zzmcheng
http://www.mp3dev.org
http://www.Microsoft.com
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